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A step by step guide for building your Prusa Mendel 3D Printer Kit.

The following instructions will take you through every step to build and commission your Prusa Mendel 
3D printer. All the parts required are included in your kit. We recommend you read through the complete 
manual to familiarize yourself with the process before starting. We also recommend you read the 
following important points about your kit and the parts it contains.

Plastic Parts
All our plastic parts are printed on the same printers that you will be building. The parts are built at 
varying densities to suit their application. Some are required to be stronger than others.

You should take special care when inserting bearings or nuts into plastic part recesses. Some parts 
have more fragile areas. When inserting bearings ensure the part is held firmly on a flat surface, ensuring 
there is no force on fragile areas. Then push the bearing into the recess, increase the force until the 
bearing clips into place. If you cannot get the bearing in place, using a pair of large pliers and a small 
amount of force should ensure they go all the way in, always ensure you keep the bearing level and 
avoid pushing in at an angle.

Plastic parts will wear over time. You should regularly follow the the maintenance tips in the manual to 
ensure your printer remains reliable. We recommend that if your first purpose is not to build yourself or a 
friend a second printer then you should print a spare set of parts for your own. This will help you in the 
future should a critical part wear out. This is also a great way to familiarize yourself with the print 
process and all the files you need are included on the CD-Rom.

This manual is available to view and download as a pdf on our website http://www.nextdayreprap.co.uk
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Health & Safety

This is a kit of components for assembly into a 3D Printer by the end user. Building and using the printer is 
potentially very dangerous as it involves electricity and high temperatures. 

Building the printer will require a certain amount of physical dexterity, common sense and a thorough 
understanding of what you are doing. We have provided this fully comprehensive build documentation to 
enable you to build your Prusa Mendel 3D Printer Kit in a safe manner, we have pre assembled many of the 
more complicated components, such as the electronics to make it easier for you.

However ultimately we cannot be responsible for your health and safety whilst building or operating the 
printer, with that in mind be sure you are confident with what you are doing prior to commencing with building 
or buying. Read all of the manual to enable you to make an informed decision.

Building and operating involves electricity, so all necessary precautions should be taken and adhered to, the 
printer runs on 12V supplied by a certified power supply, so you shouldn’t ever have to get involved with 
anything over 12V but bear in mind there can still be high currents involved and even at 12V they shouldn’t be 
taken lightly. 

High temperatures are involved with 3D Printing, the Extrusion nozzle of the hot end runs at 230°C, the 
heated bed runs a 110°C and the molten plastic extruded will initially be at around 200°C, so special care and 
attention should be made when handling these parts of the printer during operation.

We wouldn’t recommend leaving your printer running un attended, or at least until you are confident to do so. 
We cannot be held responsible for any loss, damage, threat, hurt or other negligent result from either building 
or using the printer.
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Check Kit Contents & Familiarize yourself with the kit components 

Below is a complete list of all the components within your kit, please check everything is present prior to 
starting your build. It includes everything you need to build your printer and start printing, except for a 
computer! If anything is missing please advise us straight away.

	 Tools & Ancillaries
 
	 0.1 	 Build Manual
	 0.2	 Operation Manual
	 0.3	 Software CD/Flash Drive
	 0.4	 33M 20mm Kapton Tape
	 0.5	 Cable Ties
	 0.11	 .25 Kg White 3mm ABS Filament
	 0.12	 Silver Tape
	 0.13	 Cable Tidy

	 1.0 Electronics 

	 1.1	 Fully assembled RAMPS 1.4 Wired & Soldered with Hot end power & Thermistor attached.

	 1.2	 Ramps Power Cables

	 1.3	 3x Mechanical Endstops with Completed Wiring
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	 1.4	 550W ATX PSU

	 1.5	 ATX Power Supply Adaptor (to switch PSU)

	 1.6	 V2 Heat bed with Surface Mount LEDs/Resistor & Soldered Power Cable (inc Thermistor)

	 1.7	 5 x Nema 17 Stepper Motors with Connectors & Crimps

©2012 NextDayReprap                                                                             Prusa Mendel Kit Build Manual  V1.01 - 07/2012



1.0 Bill of Materials  - Reprap Prusa Mendel Build Manual

	 1.8	 Fully assembled Hot End wired for Power & Thermistor with Mini Fit Molex connectors.

	 1.9	 Mains Power Lead (Kettle Type) & 1M USB 2.0 Cable

	 2.0 Rod

	 2.1	 6x 300mm A2 Stainless 1.25mm Pitch Threaded Rod - YUP

	 2.2	 2x 450mm BZP 1.25mm Pitch Threaded Rod

	 2.3	 1x 320mm BZP 1.25mm Pitch Threaded

	 2.4	 6x 380mm BZP 1.25mm Pitch Threaded Rod

	 2.5	 2x 330mm Bright Stainless Steel Round Rod - YUP

	 2.6	 2x 400mm Steel Round Rod
 
	 2.7	 2x 400mm Steel Round Rod

	 2.8	 1x 16mm Steel Round Rod ( Extruder Idler)

	 2.9	 1x 50mm Threaded Rod (X Idler)
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	 3.0 Nuts & Bolts

	 3.1	 6 x M2 16mm Hex Socket Bolts
	
	 3.2	 30x M3 10mm Hex Socket Bolts

	 3.3	 15x M3 20mm Hex Socket Bolts

	 3.4	 2x M3 40mm Hex Socket Bolts

	 3.5	 2x M4 50mm Hex Socket Bolts

	 3.6	 2x M4 45mm Hex Head Bolts

	 3.7	 4x M4 40mm Countersunk Hex Socket Bolts

	 3.8	 6x M8 30mm Fender/Penny Washers

	 3.9	 6x M2 Nuts 

	 3.10	 28x M3 Nuts

	 3.11	 8x M4 Nuts

	 3.12	 86x M8 Nuts

	 3.13	 2x M3 Nylock Nuts

	 3.14	 1x M8 Nylock Nuts

	 3.15	 12x M2 Washers

	 3.16	 56x M3 Washers

	 3.17	 16x M4 Washers

	 3.18	 88x M8 Washers

	 3.19	 1x Hobbed Bolt

	 3.20	 1x M3 10mm Grub Screw (Extruder Small Gear)
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	 4.0 Bearings & Pulleys & Couplings

	 4.1	 12x LM8UU Bearings (1 Spare) (Some may have been pre fitted to the printed parts)

	 4.2	 9 x 608ZZ Bearings (1 Spare)

	 4.3	 2x 12 tooth T5 XL Aluminum Pulleys

	 4.4	 2x Rigid Z Axis Couplings
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	 5.0 Springs

	 5.1	 4 x Heat Bed Springs

	 5.2	 2x Z Axis Springs

	 5.3	 2x Extruder Springs

	 6.0 Timing Belts

	 6.1	 2x 1M Brecoflex 6mm T5 Belt
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	 7.0 Build Plate

	 7.1	 Laser Cut Aluminum Build Bed

	 7.2	 Laser Cut Plywood Build Bed Top Plate

	 7.4	 4x 51mm Bull Dog Clips

	 7.5	 225cm x 225cm Build Plate Mirror
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	 8.0 Printed Parts

	 8.1	 4x Bar Clamps 

	 8.2	 2 x Rod Clamps

	 8.3	 4 x Belt Clamps

	 8.4	 3 x Endstop Holder

	 8.5	 4 x LM8UU Bearing Pillows
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	 8.6	 	 1 x Extruder
	 	 8.6.1 	 1 x Extruder Idler
	 	 8.6.2 	 1x Extruder Large Gear
	 	 8.6.3 	 1x Extruder Small Gear	

	

	 8.7	 2 x Frame Vertex

	 8.8	 4x Frame Vertex with Foot
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	 8.9	 2x Lower Z Mount

	
	 8.10	 1 x X Motor Mount

	 8.11	 1 x X Idler

	 8.12	 1x Y Motor Mount
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	 8.13	 2x  Z Motor Mount

	 8.14	 1 x X Carriage

	 8.15	 1x Hot End Clamp

	 8.16	 1x Ramps Box
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	 All Printed Parts
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A step by step guide for building your Prusa Mendel 3D Printer Kit.

2.1 	 Parts Required
	 2 x Lower Z Mount
	 2 x Frame Vertex
	 4 x Frame Vertex
	 4 x Bar Clamp
	 1 x Y Motor Mount
	 2 x Z Motor Mount
	 6 x 380mm Threaded Rod
	 4 x 300mm Threaded Rod
	 1 x 320mm Threaded Rod
	 2 x 450mm Threaded Rod
	 4 x M8 Fender Washers
	 80 x M8 Washers
	 78 x M8 Nuts
	 4 x 608 Bearings

2.2 	 Assembly

Step 1
Take one Lower Z Mount and push in one 608 Bearing. Push down against a solid flat surface 
to ensure the bearing sits flush in the plastic part.
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Step 2
Take one 380mm Threaded Rod and thread on the following parts from left to right. M8 Nut/M8 
Washer/Vertex with Foot/M8 Washer/M8 Nut/M8 Nut/M8 Washer/Lower Z Mount/M8 Washer/
M8 Nut/M8 Nut/M8 Washer/Vertex with Foot/M8 Washer/M8 Nut. Space the parts as in the 
photo below. Leave approximately 5mm of thread showing on the end of the rods. The Lower Z 
mount should be central on the rod. Do not over tighten the M8 Nuts. Leave them finger tight 
at this stage.

Step 3
Take one 380 mm Threaded Rod and thread on the following parts from left to right. M8 
Washer/M8 Nut/M8 Nut/M8 Washer/Frame Vertex/M8 Washer/M8 Nut. Space apart as in the 
photo below.



 2.0 Frame Assembly - Reprap Prusa Mendel Build Manual

©2012 NextDayReprap                                                                                        Prusa Mendel Kit Build Manual  V1.01 - 07/2012

Step 4
Take another 380 mm Threaded Rod and thread on the following parts from left to right. M8 
Nut/M8 Washer/M8 Nut. Push this rod through the Frame Vertex from step 3 and attach an M8 
washer and M8 nut to secure it. Your component should look like the photo below.

Step 5
Take your component from step one and thread it on to the component from step four. Add an 
M8 washer and M8 nut to the end of the threaded rods. Your component should look like the 
photo below.
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Step 6
Now measure the distance between the inside edges of the printed frame vertices. Make this 
gap 290 mm. Loosely tighten the M8 nuts against the vertices and adjust evenly until all three 
sides are 290mm. The Lower Z Mount should be left loose and approximately in the centre of 
the rod. Check your measurements and tighten the M8 nuts against the vertices ensuring your 
frame side is stiff and even.

Step 7
Repeat steps 1 to 6 and you should now have two frame sides. Place these to one side.
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Step 8
Take one 300mm Threaded Rod and thread on the following parts from left to right. M8 
Washer/M8 Nut/M8 Nut/M8 Washer. This component should look like the photo below.

Step 9
Take one 300mm threaded rod and thread on the following parts from left to right. M8 Washer/
M8 Nut/M8 Nut/M8 Washer/Bar Clamp/M8 Washer/M8 Nut/M8 Nut/Fender Washer/M8 
Washer/608 Bearing/M8 Washer/Fender Washer/M8 Nut/M8 Nut/M8 Nut/M8 Washer/Bar 
Clamp/M8 Washer/M8 Nut/M8 Nut/M8 Washer.This component should look like the photo 
below.
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Step 10	
Take two 300mm threaded rods. Thread the Y Motor Bracket on to both rods as in the photo 
below.

Then thread all of the following parts on the upper threaded rod (The upper rod is the one that 
is closest to the longer flat edge on the Y Motor Bracket), from left to right. M8 Washer/M8 
Nut/M8 Nut/M8 Washer/Bar Clamp/M8 Washer/M8 Nut/M8 Nut/Fender Washer/M8 Washer/
608 Bearing/M8 Washer/Fender Washer/M8 Nut/M8 Washer/Y Motor Bracket/M8 Washer/M8 
Nut/M8 Nut/M8 Washer/Bar Clamp/M8 Washer/M8 Nut/M8 Nut/M8 Washer. 

Then Thread the following parts on the lower threaded rod, from left to right. M8 Washer/M8 
Nut/M8 Nut/M8 Washer/Y Motor Bracket/M8 Washer/M8 Nut/M8 Nut/M8 Washer. This 
component should look like the photo below.
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Step 12
Take one 320 mm threaded rod and thread it with the following parts from left to right. M8 
Washer/M8 Nut/M8 Nut/M8 Washer. Space them as in the photo below.

Step 11
Take two 450 mm threaded rods and thread them each with the following parts from left to 
right. M8 Washer/M8 Nut/M8 Nut/M8 Washer. Space them as in the photo below (leave 
approximately 100mm of threaded rod on each end).
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Step 14	
Take the rod from step ten and thread through the vertex with foot as the photo below. Use an 
M8 Washer and M8 Nut on each rod to secure it. Ensure the longer flat edge of the Y Motor 
Bracket is at the bottom.

Step 13 	
The next steps will take you through joining your two triangle components together using the 
rods created in steps 8 to 12. Take one of the frame sides you completed in step seven and the 
threaded rod from step from step 12. Slide the threaded rod through the lower Z mount and 
add an M8 Washer and M8 Nut to secure it. Ensure the Lower Z mount has the 608 bearing 
facing up.
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Step 16 	
Take the rod from step nine and thread through the upper hole on the second vertex foot. Use 
an M8 Washer and M8 Nut to secure it.

Step 15	
Take the rod from step eight and thread through the lower hole on the second vertex foot. Use 
an M8 Washer and M8 Nut to secure it.
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Step 18
You can now attach the second frame side from step seven. Push it onto each of the roads 
ensuring the lower Z mounts both face outwards with the 608 bearing upwards. Secure the 
end of each of the threaded rods with an M8 Nut and M8 Washer. Your frame should look like 
the picture below.

Step 17
Take a 450 mm Rod from step eleven and slide them through the upper frame vertices. Use an 
M8 Washer and M8 Nut to secure it.
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Step 20
Add a washer to each end of both 450 mm threaded bars that go through the upper vertices, 
then push on the Z Motor Mounts to each side. If you had to make adjustments for leveling you 
may find you need to add one or two extra M8 Washers between the frame vertices and Z 
motor mounts for them to sit flat in line with the upper frame vertices. Add an M8 Washer and 
M8 Nut to each rod and loosely tighten the rod clamp side, then firmly tighten the plain side. 
Once attached it should look like the picture below note that the clamp is loose.

Step 19
You can now adjust the width of the frame. Gently tighten the frame until the gap between the 
inside edges of the vertices is 250mm. Adjust each rod gradually tightening until all are 250mm 
gaps once tight your frame should be solid and sturdy on a level surface if you find your frame 
wobbles when on a flat surface check the spacing between vertices and ensure they are 
290mm between vertices on the triangle sides and 250mm across the width. Adjust your frame 
in opposite corners by approximately 2 mm at a time until until your frame is solid. The lower Z 
mounts should still be loose and sit approximately central.
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3.1 	 Parts Required
	 2x 400mm Smooth Rod
	 4 x LM8UU Bearing

3.2 	 Assembly

Step 1
Ensure the M8 nuts holding the Rod Clamps in position are loose and then slide a 400mm 
Smooth Rod through from one side. Before pushing the rod into the second rod clamp slide 
two LM8UU Bearings on to the rod. Repeat this for both rods. It should look like the picture 
below.

Step 2
Slide the rods into the second rod clamps. Centre the rods 50mm from the inside edge of the 
frame vertices. Do not fully tighten yet. ensure the rod clamp has 1-2mm of play. These will be 
adjusted and tightened during the Y Carriage Assembly.
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4.1 	 Parts Required
	
	 1 x X Motor Mount
	 1 x X Idler End
	 1 x X Carriage
	 2 x Belt Clamps
	 2 x Z Axis Springs
	 2 x Rod Clamps
	 2 x 300mm Smooth Rod
	 2 x 400mm Smooth Rod
	 2 x Aluminum Couplings
	 7 x LM8UU Bearings
	 8 x M3 Washer
	 8 x M3 20mm Bolt
	 8 x M3 Nut
	 1 x 50mm Threaded Rod
	 4 x M8 Nut
	 2 x M8 Fender Washer
	 5 x M8 Washer

4.2 	 Assembly

Step 1
This step may already be completed and your X Mounts will have bearings installed and 
secured with cable ties. If so go on to step two.

Take the X End Idler and push two LM8UU Bearings into the side recesses. Push in until the 
bearings locate fully in the bearing guides. Repeat this bearing installation on the X Motor 
Mount. Be careful not to put pressure on to the brackets on these parts.
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Step 2
Take one 300mm Threaded Rod and thread on one M8 nut approximately 100mm on from the 
left. Slide a Z Axis Spring  on from the opposite end. Repeat this step so you have two rods.

Step 3
Take one rod push through the X end idler so that the spring is compressed inside the deep 
hexagonal recess on the part, then thread an M8 Nut on from the opposite end and thread on 
until it meets the X end idler base. Keep the spring compressed and twist the rod to locate the 
nut into the recess of the X End Idler. Once the lower nut is located, release the pressure on the 
spring and the rod should be held in place with the spring pushing out against the nuts. Twist 
the rod and ensure it twists through the nuts cleanly and smoothly. Repeat this with the second 
rod and X Motor Mount.
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Step 4
Now take two 400mm smooth rods and push in to the horizontal holes on the X end idler. Then 
slide two LM8UU Bearings onto the rod closest to the motor mounting point. Slide one LM8UU 
Bearing on to the other smooth rod. Check the picture below to ensure your bearings are on 
the correct rods.

Step 5
Slide the X Motor Mount onto the rods and then slide two 300mm smooth rods through the 
LM8UU bearings in each X end part. It should now look like the photo below.
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Step 6
Take the XY axis you have made and position into the frame as in the photo below. Pass the 
axis through the centre of the frame. Straighten the axis and slide the threaded rods through 
the 608 bearings in the lower Z Mounts, now slide the smooth rods on the XY axis up into the Z 
Motor mount clamps. secure the top of the rods in the clamps by tightening the M8 nuts on the 
450mm Threaded Rod top bars.

Step 7
Locate the bottom of the smooth rod in the cut-out on the lower Z Mount. Place an M3 Nut in 
each of the recesses on the lower Z mounts. secure the smooth rods using M3 20mm Bolts 
and M3 Washers and the two Rod Clamps.
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Step 8
Take the X carriage and attach two Belt Clamps using 20 mm M8 bolts and Washers and push 
M8 Nuts into the recesses on the underside. Leave the belt clamps loose. Then place the X 
carriage onto the X axis bearings and ensure the bearings are located correctly. They should sit 
snug in the X carriage. Use small zip ties to secure the carriage.

Step 9
Take the 50mm threaded rod and thread on two M8 Nuts and an M8 Washer. Thread this 
though the hole on the X end idler. Then thread on the following parts. M8 Washer/Fender 
Washer/M8 Washer/608 Bearing/M8 Washer/Fender Washer/M8 Nut/M8 Nut. Tighten the M8 
Nuts against each other to ensure the idler is tight and the rod does not wobble but the 608 
bearing is free to spin.
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A step by step guide for building your Prusa Mendel 3D Printer Kit.

5.1 	 Parts Required
	 1 x Aluminum Bed
	 4 x LM8UU Bearing Pillow
	 2 x Belt Clamp
	 8 x M3 10mm Bolt
	 4 x M3 20mm Bolt
	 12 x M3 Nut
	 16 x M3 Washer

5.2 	 Assembly

Step 1
Take the four LM8UU bearing pillows and push M3 Nuts into each of the recesses. Attach the 
bearing pillows to the aluminum bed using 10 mm M3 Bolts and M3 Washers. On the opposite 
side of the aluminum bed attached two Belt Clamps using 20mm M3 Bolts and M3 Washers 
with M3 Nuts and M3 Washers on the underside.
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Step 2
Place the bed over the Y axis smooth rods. Check the below picture to ensure your bed is 
orientated the correct way. The belt clamps on the bed should line up with the 608 Bearings on 
the frame. Lineup the bearings on the Y smooth rods and carefully clip the pillows on to the 
bearing. Ensure you line up the bearings correctly before applying any pressure to the LM8UU 
bearing pillow.

If you feel unsure about how much pressure is required you may find is easier to remove the Y 
smooth rods and slide off the 4 LM8UU Bearings. You can then install them in the pillows first. 
Then slide the whole bed back on and put the Y rods back in place. You can also loosen the 
M3 bolts holding the LM8UU Bearing Pillows to allow more adjustment. Once the bed is in 
place go round and gradually tighten the bar clamps holding the Y rods. While tightening slide 
the bed back and forward and adjust by tightening the M8 nuts against the bar clamps until 
they are all tight and the bed maintains a smooth action. Adding a small amount of bearing 
grease to the Smooth Rods can help ensure your bed runs smoothly.



6.0 	 Motor/Belt/Endstop Assembly - Reprap Prusa Mendel Build Manual

©2012 NextDayReprap                                                                                        Prusa Mendel Kit Build Manual  V1.01 - 07/2012

6.1 	 Parts Required
	 4 x Nema Stepper Motor
	 2 x Aluminum Pulley
	 2 x T5 Belt
	 3 x Endstop Holder
	 3 x Microswitch
	 2 x Carbon Tube Insert
	 6 x M2 15mm Bolt
	 6 x M2 Nut
	 12 x M2 Washer
	 14 x M3 10mm
	 17 x M3 Washer

6.2 	 Assembly

Step 1
Attach one aluminum pulley in to a Nema stepper motor ensuring the grub screw end is closest 
to the motor body the motor shaft should be flush with the pulleys edge. Tighten the grub 
screw against the flat side of the motor spindle. Mount the motor on to the Y motor mount 
using 10mm M3 Bolts.
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Step 2
Take another nema stepper motor and aluminum pulley and attach the pulley the opposite way 
round to the previous step. The grub screw end should be furtherest from the motor body. The 
motor shaft should be flush with the pulleys edge. Tighten the grub screw against the flat side 
of the motor spindle. Mount the motor on the X motor mount using 10mm M3 Bolts.

Step 3
Mount two Nema stepper motors in the Z motor mounts with the shafts pointing down. Attach 
using four M3 10mm Bolts M3 Washers for each motor.
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Step 4
Attach an aluminum coupling to the top of the Z axis threaded rod and tighten the grub screw. 
Repeat for the second Z axis. Then lift the XZ axis assembly so that the aluminum couplings 
meet the Z motor shafts. Ensure the grub screws in the couplings line up with flat part of the 
motor shaft and once fully in position tighten the grub screws against the motor shafts. Once 
both couplings are in place they should support the X axis. Now level the the X axis by 
measuring the height from your work surface to the bottom of once of the X End plastic parts. 
Now hold the coupling still on that the side you measured and turn the coupling on the other 
side. the X Mount should move up or down, you can now adjust in the required direction until 
both X Mounts are the same height from your work surface.

Step 5
Take a T5 Belt and run it around the X Idler Bearing and the X Motor pulley. Bring the ends 
together under the belt clamps on the X carriage. Pull the ends through until the belt is tight but 
does not strain the X idler mount. Tighten the M3 Bolts in the X Carriage to hold the belt in 
place.
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Step 6
Take the second T5 Belt and run around the 608 Bearings and the Y motor pulley, place the 
ends under the belt clamps on the aluminum bed and tighten the M3 bolts just enough to hold 
the belt still. now adjust the M8 Nuts either side of the 608 Bearings on the frame and move 
until the belt, bearings and pulleys all run in a straight line, gradually tighten the M8 Nuts, the 
Belt Clamps and the Y motor Mount while sliding the bed back and forward and ensure the 
belt runs straight, the bed should move smoothly, however you may feel some resistance from 
the stepper motors. Only a small amount of force should be needed to move the bed and it 
should not have a jerky motion. Once you are happy gradually tighten the Nuts and tighten the 
belt clamps down.

Step 7
Take a microswitch and attach it to an Endstop Holder using 20mm M2 Bolts with an M2 
Washer on each side and an M2 Nut.
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Step 8
Using 20mm M3 Bolts with a washer and an M3 Nut placed in the End Stop Holder recess, 
attach the first Endstop assembly to the Z Axis Smooth Rod underneath the X Idler. It should 
be positioned so the microswitch is depressed when the X Idler comes down the Z axis and 
hits the microswitch, before hitting the print bed. Loosely attach and this will be adjusted when 
the print bed is assembled. Place the second of the Endstop assemblies on the X Axis smooth 
rod where is will be activated when the X Carriage returns along the X axis. Place the third 
assembly on the Y axis smooth rod to the right of the Y Motor, this will be activated by the 
aluminum bed.
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7.1 	 Parts Required
	
	 1 x Wooden Bed
	 4 x Bed Springs
	 4 x M4 Countersunk Bolts
	 1 x Bed Thermistor
	 1 x Heated Bed
	 1 x Aluminum Tape
	 4 x M4 Nut
	 12 x M4 Washer
	 6 x Bulldog Clip

7.2 	 Assembly

Step 1
Lay the Wooden Bed with the countersunk holes face down and the cut out at the bottom. 
Using the Aluminum Tape attach the Bed Thermistor to the Wooden Bed. The thermistor 
should poke through the central hole on the bed about 1mm. Tape this securely and run the 
cable to the right.
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Step 2
Place the wooden bed over the Aluminum Bed on your printer. The Aluminum tape should be 
facing down and the cut out in the Wooden Bed should be at the front of the frame (The Y 
Motor Is the rear of the frame). Secure this in place using the M4 Countersunk Bolts. Thread 
the bolt through the Wooden Bed, Then thread on an M4 Washer, Bed Spring and M4 Washer, 
thread through the Aluminum Bed and add an M4 Washer and M4 Nut. Repeat this in each 
corner and then tighten down so that the springs compress to 2/3rds of the original length. 
Measure the gap between the wooden bed and aluminium bed in one sprung corner and then 
adjust the other corners to the same height. You can also use a small spirit level to ensure the 
bed is as level as possible. Place the spirit level on each side of the wooden bed and adjust the 
sprung bolts to get an even level at each edge. Then place the spirit level diagonally across the 
bed to and adjust the sprung bolts if necessary.
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Step 3
Place the Heated Bed on the Wooden bed, thread the cables under the wooden bed and follow 
the thermistor cables out the left hand side. Position the centre of the Heated Bed over the 
thermistor in the centre of the wooden bed and hold in place with the 6 bulldog clips. Once in 
place remove the silver spring arms from the bulldog clips, leaving the black clamps in place.
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8.1 	 Parts Required
	 1 x Hot End
	 1 x Extruder
	 1 x Extruder Idler
	 1 x Extruder Large Gear
	 1 x Extruder Small Gear
	 1 x Hot End Clamp
	 1 x Hobbed Bolt
	 4 x M8 Washer
	 1 x M8 Nylock Nut
	 3 x 608 Bearing
	 1 x 16mm Smooth Rod
	 2 x M3 40mm Bolt
	 2 x M3 Nylock Nut
	 4 x M3 Washer
	 2 x M4 50mm Bolt
	 4 x M4 Nut
	 6 x M4 Washer
	 2 x Extruder Spring
	 1 x Nema Stepper Motor
	 1 x M3 Grub Screw
	 1 x M3 Nut
	 3 x M3 10mm Bolt

8.2 	 Assembly

Step 1
Take the 16mm Smooth Rod and slide through a 608 Bearing. Place this into the Extruder idler. 
Push in until the Smooth Rod is fully located. Using a 40mm M3 Bolt with M3 washer and M3 
Nylock Nut attach the idler to the Extruder.
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Step 2
Push a 608 Bearing in to the recess on the flat side of the extruder. Take the Hobbed Bolt and 
slide on the Extruder large gear. Then Thread on 4 M8 Washers, one 608 Bearing and 1 M8 
Washer. Slide the hobbed bolt through the Extruder and through the 608 Bearing. Add 2 M8 
Washers and an M8 Nylock Nut and tighten together until there is no wobble on the Hobbed 
Bolt but the Extruder Large Gear turns freely.

Step 3
Push 2 M4 Nuts in to the recesses on the top of the Extruder and pull up the the idler. Take two 
40mm M4 Bolts and thread on each an M4 Washer, Idler Spring and M4 Washer. Push through 
the idler and screw into the M4 bolts in the recesses. Ensure the bolts screw in and compress 
the springs then loosen the bolts back off.
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Step 4
Take the Extrude Small Gear and push an M3 Nut in to the recess, secure the nut using an M3 
Grub Screw. Take a Nema Stepper Motor and Line up the grub screw with the flat part of the 
motor shaft and push the gear onto the shaft. The Motor shaft should be flush with the edge of 
the gear. Tighten the grub screw.

Step 5
Attach the motor to the Extruder using three 10mm M3 Bolts. when in position loosen the bolts 
a little and push the motor in so the gears fit as tightly as possible against the Large Gear. Then 
tighten the motor in place.



      
 8.3   Hot End Connection

8.0	 Extruder & Hot End Assembly - Reprap Prusa Mendel Build Manual

©2012 NextDayReprap                                                                                        Prusa Mendel Kit Build Manual  V1.01 - 07/2012

Step 6
Take the Hot End Clamp and push a M3 Nylock nut in to the recess on the side. Secure with a 
40mm M3 Bolt and M3 Washer. The clamp can be very tight, this is to ensure the hot end stays  
in place. You may find it useful to use a longer M3 bolt. There will be one in the spare parts 
bag. Leave the clamp loose. 

Push two 50mm Hex Top Bolts through the base of the extruder so the heads locate in the 
recesses. Slide the Hot end clamp on to the Hex Top Bolts. Ensure that the clamp opening is 
on the same side as the extruder gear. The clamp only fits on to the X Carriage one way so if it 
is the incorrect way round, your Extruder will be mounted backwards.
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Step 7
Take your Hotend part and inspect it carefully before using. Check that the barrel is not loose 
and there are no gaps between components. There are two resistors running through the 
aluminum block, check there are no breaks on the connections. There is a smaller thermistor 
also in the top of the aluminum block. the glass bead on this should be inside the block. If it is 
protruding from the block or has slipped out completely, use a pair of tweezers and gently 
push it in to the aluminum block. Hold the Brass tip up to a light and look through the Hotend, 
Make sure you can see the pin hole and ensure there is no debris inside. Make sure the PTFE 
lining is pushed in fully and flush with the top of the Hotend.

Step 8
Take your Hotend Part and remove the white PTFE Disc. Push this in to the 16mm round 
recess on the bottom of the extruder. This disc acts as a barrier stopping the inner PTFE lining 
of the Hotend from being pulled out when the extruder reverses. Push it all the way through the 
clamp and in to the Extruder recess, ensure it is all the way in and flat.
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Step 9
Take your Hot end and push in to the recess to butt up against the PTFE Disc. The Hotend 
must be pushed all the way in to the extruder. Do not leave any gap between the extruder, 
PTFE Disc and Hotend. Once in place, ensure the Hotend Clamp is pushed all the way up to 
the extruder and tighten the clamp around the Hotend. 

Step 10
Now take your Extruder/Hotend assembly and feed the Hotend cables down through the 
centre of the X Carriage part. The Gears on the extruder should face the front of the printer. 
The rear of the printer (the rear has the Y Motor Mount).
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Step 12
Push the Hotend Clamp down on the the X Carriage and it should clip tightly in to place. Use 
an M4 Washer and M4 Nut on each of the hex bolts and tighten all the way up. Make sure the 
Extruder assembly is tightly held and does not wobble.

Step 11
Once the cables are through line up the Hex Bots with the X Carriage and guide the whole 
assembly down. 
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Step 13 	
Check everything is tight and that your Hotend has not moved or loosened. Feed the cables 
from the Hotend and Motor up and through the two top Threaded rods ready to connect to 
your RAMPS Board.
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9.1 	 Parts Required
	 RAMPS Board
	 Power Supply
	 USB Cable
	 5 x PC Header Black Plastic Connectors
	 20 x Crimp Terminals

9.2 	 Completing Connections

The Nema Stepper Motors that you have mounted on the printer will require the plastic PC 
Header connectors crimped and connected to the wires before you can attach them to your 
RAMPS hardware. The following instructions will guide you through the process. If you are 
experienced at this type of connection we recommend that you put small amount of solder on 
the crimps to ensure there longevity. You should always double check the order the the wires 
are connected before pushing in to the black plastic PC Header plugs as they are very difficult 

Step 1
Take the four coloured (Red, Blue, Green, Black) wires from the Nema Stepper Motor and strip 
5mm of the plastic sheath from each of the wires.
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Step 2
Take one of the Crimp connectors and place the Red stripped wire as shown below. Ensure the 
longer metal prongs on the connector line up with the sheathed part of the wire. The bare wire 
should sit in the centre of the connector.

Step 3
Now crimp down the smaller metal prongs. Ensure they hold the wire tight. Make sure there are 
no loose or frayed strands of wire.
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Step 4
Crimp the larger of the prongs around the sheathed part of the wire. Ensure these grip the 
sheathed wires, but do not crush the wire. Ensure your crimps are small and tight on the wire. 
Ensure the connector is not bent. The whole of the metal connector will slide in to the plastic 
PC Header connector so you should ensure there are no wires hanging and the metal crimp is 
secure.

Step 5
Repeat the the process until all four wires from the stepper motor have connectors attached.
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Step 6
Take a plastic PC Header connector and hold it so that the cut outs on the flat side face you. 
Line up the Red wire with your crimp connector. The crimp should have the flat side down. The 
red wire goes in to the right hand hole in the connector.

Step 7
Slide the connector in to the PC Header connector as shown in the photo. The connector must 
slide all the way in until your feel a click as the crimp connector locates in to the plastic. If your 
crimp will not go all the way in, check that your crimped prongs are tight enough. To check that 
your wire is all the way in look in to the PC Header connector and the crimp should be visible 
and you should see that it is in as far as possible.
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Step 8
Repeat fitting the connectors in the PC Header connector for each wire. Ensure the order 
matches the photo below.  From left to right it should be Black, Green, Blue and Red.

Step 9
Repeat the steps for all five of your stepper motors. You are now ready to connect to your 
RAMPS Board.
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9.3 	 RAMPS Board Diagram
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You can now connect your printer to the RAMPS Hardware. Your RAMPS board already has 
two cables connected, these are for the Hotend thermistor and power, the ends are labeled. 
You should place your ramps board the to rear left hand side of your printer. Run the Hotend 
cables over the printer and drop through the upper threaded rods Connect these to your 
Hotend. As you connect your components to the ramps board use cable ties to hold the cables  
against the frame and ensure no cables are trapped or touching moving parts. We recommend 
loosely tidying cables until your printer is fully running and then making permanent later. Make 
sure when connecting plastic connectors, that the pins are fully inserted in to the plastic plugs, 
but have not pushed the connector out of the plug housing.

9.4 	 RAMPS Board Connection

Step 1
Start by connecting the Heated Bed power cable to the screw terminals labelled D8 on the 
Ramps Board. Ensure the red wire is screwed in to the positive (+) terminal and black to 
negative (-).
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Step 3
Connect the X Endstop Microswitch to the connector labelled x. There should be two rows of 6 
pins. The x is the first pair, the next endstop connectors will use every other pair of pins. 
Ensure the black cable is closest to the centre of the RAMPS board.

Step 2
Connect the Heated Bed Thermistor to connector labelled T1. The orientation does not matter 
on this connector only.
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Step 5
Connect the Z Endstop Microswitch to the connector labelled z. Ensure the black cable is 
closest to the centre of the RAMPS board.

Step 4
Connect the Y Endstop Microswitch to the connector labelled y. Ensure the black cable is 
closest to the centre of the RAMPS board.
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Step 7
Connect the Y Motor to the connector labelled Z. Ensure the Red cable is closest to the green 
screw terminals on the RAMPS board.

Step 6
Connect the X Motor to the connector labelled X. Ensure the Red cable is closest to the green 
screw terminals on the RAMPS board.
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Step 9
Connect the second Z Motor to the upper connector labelled Z. Ensure the Red cable is 
closest to the green screw terminals on the RAMPS board.

Step 8
Connect the first Z Motor to the lower connector labelled Z. Ensure the Red cable is closest to 
the green screw terminals on the RAMPS board.
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Step 11
Connect Power Supply cable to the green socket.

Step 10
Connect the Extruder Motor to the connector labelled E0. Ensure the Red cable is closest to 
the green screw terminals on the RAMPS board.
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Step 13
You can now connect the USB cable to the RAMPS board and the other end to your computer.

Step 12
Connect the other end on the Power Supply cables to the cables on your main power supply. 
The smaller connector has only one matching connector on the main power supply. The wider 
connector will atatch to any of the matching connectors on the main power supply.



As per Steps 11, 12  in 9.0 Wiring :
	 Connect the green connector from the RAMPS Power Leads(1.2) to the green connector on the 
	 RAMPS board. Now connect the 4 Pin Square connector on the RAMPS Power Cables(1.2) onto 
	 the the lone P4 Power connector on the ATX Power Supply(1.4) and connect the rectangular 
	 connector on the RAMPS Power Cables(1.2) onto one of the rectangular power connectors on the 
	 ATX Power Supply(1.4)

Step 1
Now connect the ATX Power Supply Connector(1.5) onto the the 20Way ATX connector on the ATX Power 
Supply(1.4). Now connect the Mains Power Lead(1.9) to the ATX Power Supply(1.4) and the other end to a 
spare mains socket.

As per Step 13  in 9.0 Wiring :
	 Now connect the USB Cable(1.9) to the RAMPS Board(1.1) and connect the other end to the spare 
	 USB2.0 port on the computer. - You may notice a green light or two flash on the RAMPS Board.

Step 2
Now switch the power switch on the back of the ATX Power Supply(1.4) to the on position. -  The fan on 
the Power Supply should start to spin.
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10.1 	Connecting Hardware & Driver Installation 

	 10.1.1	Hardware Setup & Connection.

Ensure your computer is in good working order and you have a free USB 2.0 port and a mains power 
socket within reach.

Boot up your computer and either insert the software CD that came with your Kit or navigate to http://
arduino.cc/hu/Main/Software . Create a folder called “REPRAP” wherever you want to work/run your 3D 
Printer from and then either Download Ver 1.0 (MUST BE THIS VERSION) of the Ardunio Dev Environment 
or copy from the CD the Folder called “ARDUINO 1.0” and place inside the newly created “REPRAP” 
folder.

	 Parts Required
	 0.3 Software CD 
	 1.1 Fully Assembled RAMPS
	 1.2 Ramps Power Cables
	 1.4 550W Silent ATX Power Supply
	 1.5 ATX Power Supply Adaptor
	 1.9 Mains Power Lead & 
	       USB 2.0 Cable

http://arduino.cc/hu/Main/Software
http://arduino.cc/hu/Main/Software
http://arduino.cc/hu/Main/Software
http://arduino.cc/hu/Main/Software


Step 2
Select “Install from a Specific Location” and Select “Next”.

Step 3
Select “Don’t Search I will Choose the Driver to Install” and Select “Next”.

Step 1
A “Found New Hardware Wizard” Dialogue window should appear, Select “No, not this time” and 
select “Next”.

10.1 	Connecting Hardware & Driver Installation 

	 10.1.2	Ardunio Driver - Windows XP Installation 
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Step 4
Select “Ports (COM & LPT)” and Select “Next”.

Step 5
Select “Have Disk”.

Step 6
Select “Browse”.
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Step 7
Navigate to your “Arduino 1.0” folder and then into “Drivers”.

Step 8
Select “Ardunio MEGA 2560 REV3.inf” and select “Open”.

Step 9 
Select “Ardunio MEGA 2560 R3” and select “Next”.
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Step 11
Select “Finish”.

Your Ramps Board is now setup to communicate with your computer, you should see the following 
message pop up after selecting “Finish”. Now proceed to “1.11 Setting Port Speed”.

Step 10
Select “Continue Anyway.
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10.1 	Connecting Hardware & Driver Installation 
	 10.1.2	Ardunio Driver - Windows XP Installation 
	 	 10.1.2.1	 Setting Port Speed - Windows XP 
Installation

We now need to set the correct port speed for the new serial port we have just created by installing 
the Arduino driver in the previous section. 

Step 1
Navigate to the “Windows Control Panel”  and select “system” and select the “hardware “ tab.

Step 2
Navigate to “Ports (COM & LPT)”  and expand it by selecting the “+” symbol, now select “Arduino 
MEGA 2560 R3” and right click and select “Properties” .
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Step 3
Make a note of the COM Port your computer has allocated, we will need this later on when we’re 
setting up the printing software (in brackets after the device title). Then Select the “Port Settings” 
Tab.

Step 4
Select “Bits per second”.

Step 5
Select the “115200” from the drop down menu.
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Step 1
After connecting the USB Cable to the Computer either a “Found New Hardware Wizard” Dialogue 
window will appear, or a dialogue box as below, either way just close the respective window.

Step 2
Navigate to the Windows Control Panel and Select “System” and then select “Device Manager” on 
the top left hand side. You should then be able to see an “unknown device” under “other devices”

Step 3
Right click over the “unknown device” and select “properties”.

10.1 	Connecting Hardware & Driver Installation 

	 10.1.3 	Ardunio Driver - Windows 7 / Vista
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Step 4
Select “Update Driver”.

Step 5
Select “Browse my computer for driver software”.

Step 6
Select “Browse”.
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Step 7
Select “Ports (COM & LPT)”.

Step 8
Select “Have Disk”

Step 9
Select “Browse”
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Step 10
Navigate to Where you located the “Arduino 1.0” folder, then go into the “drivers” folder and then 
select “Arduino MEGA 2560 REV3.inf” and click “Open”

Step 11
Select “Ok”.

Step 12
Select “Arduino Mega 2560 R3” then select “Next”.
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Step 13
Select “Install this driver software anyway”.

Step 14
After a short while (it could be up to a few minutes depending on your computer speed) the 
following message should appear, then select “Close”.
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10.1 	Connecting Hardware & Driver Installation 
	 10.1.3	Ardunio Driver - Windows 7 / Vista
	 	 10.1.3.1	 Setting Port Speed - Windows 7 / Vista Installation

We now need to set the correct port speed for the new serial port we have just created by installing 
the Arduino driver in the previous section. 

Step 1
Navigate to the Windows Control Panel and select “System” and then select device manager from 
the top left hand side.

Step 2
Navigate to “Ports (COM & LPT) and expand by selecting the triangle/arrow to the left of it, then 
right click over “Arduino Mega 2560 R3 (COM?)” and select “Properties”
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Step 3
Make a note of the COM port your computer has allocated to the Arduino 
Serial Port, in the title “COM”, you will need this later when setting up your 
printer software. Now select “Port Settings”

Step 4
Select the “Bits per second” drop down menu and select “115200”, then select “Ok”

Step 5
Select “Ok”, now we have set the port speed we.
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10.2 	Arduino Software Installation

	 10.2.1	Ardunio Software - Windows XP Installation 

Install application
Insert the software CD that came with your Kit or navigate to http://arduino.cc/hu/Main/Software . 
then either Download Ver 0.22 (MUST BE THIS VERSION) of the Ardunio Dev Environment or copy 
it from the CD, take the Folder called “ARDUINO 022” and place inside the newly created 
“REPRAP” folder. Make sure that when you download the software that you unzip/extract it before 
placing into your “REPRAP FOLDER

Create Shortcut
Now navigate into the “Arduino 022” folder and locate “arduino.exe” right click on it and select 
“send to -> Desktop (create shortcut)”, this will make things easier later on.

Install application
Insert the software CD that came with your Kit or navigate to http://arduino.cc/hu/Main/Software . 
then either Download Ver 0.22 (MUST BE THIS VERSION) of the Ardunio Dev Environment or copy 
it from the CD, take the Folder called “ARDUINO 022” and place inside the newly created 
“REPRAP” folder. Make sure that when you download the software that you unzip/extract it before 
placing into your “REPRAP FOLDER

Create Shortcut
Now navigate into the “Arduino 022” folder and locate “arduino.exe” right click on it and select 
“send to -> Desktop (create shortcut)”, this will make things easier later on.

	 10.2.2	Ardunio Software - Windows 7 / Vista
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Step 1
Navigate to The “Python 2.7.2” folder and then select “python-2.7.2.msi” or download from http://
python.org/ftp/python/2.7.2/python-2.7.2.msi

Step 2
Select “Next” and install Python 2.7.2 

Step 3
Now we’ve installed Python 2.7 we need to install PYSerial for Python, Navigate to the “PYSerial” 
folder and select “pyserial-2.5.win32.exe”, or download from http://pypi.python.org/packages/any/p/
pyserial/pyserial-2.5.win32.exe

10.3	 Python Environment & Dependencies Installation

	 10.3.1	Python Environment & Dependencies - Windows XP Installation
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Step 4
Select “Next” and complete the installation of PY Serial.

Step 5
Install Python 8 support, Navigate to “Python 8 “ folder and select “wxPython2.8-win32-
unicode-2.8.12.0-py27.exe“, or download here http://downloads.sourceforge.net/wxpython/
wxPython2.8-win32-unicode-2.8.12.0-py27.exe

Step 6
Select “Next” and follow the instructions to install Python 8 support, On the final dialogue 
(installation complete) screen un tick “convert .py files to.pyc” and select “Finish”
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Step 7
Navigate to the “PYREADLINE” Folder and select “pyreadline-1.7.win32.exe, or download 
here : http://launchpad.net/pyreadline/1.7/1.7/+download/pyreadline-1.7.win32.exe

Step 8
Select “Next” and follow the instructions to complete the installation of pyreadline 1.7.

Step 9
Now we need to install PYGLET, First navigate to your reprap folder and check that you have a 
folder called “pyglet-1.1.4”, Alternatively download here http://pyglet.googlecode.com/files/
pyglet-1.1.4.zip
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Step 10
Select “Start” and then select “Run” and type “cmd”.

Step 11
At the command prompt, navigate to the “pyglet-1.1.4” folder. - from your home directory, “cd 
desktop”, “cd REPRAP”, “cd PYGLET”, “cd pyglet-1.1.4”. Now you should be in the pyglet-1.1.4 
folder, now type “setup.py install” and press return.

Step 12
You should now see some text passing the screen, which should complete the installation of 
Pyglet, once this is comeplete, type “exit” and press “return”.
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Step 2
Select “Next” and install Python 2.7.2 

10.3	 Python Environment & Dependencies Installation

	 10.3.2	Python Environment & Dependencies - Windows 7 / Vista



Step 1
Navigate to The “Python 2.7.2” folder and then select “python-2.7.2.msi” or download from http://
python.org/ftp/python/2.7.2/python-2.7.2.msi
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Step 3
Now we’ve installed Python 2.7 we need to install PYSerial for Python, 
Navigate to the “PYSerial” folder and select “pyserial-2.5.win32.exe”, or 
download from http://pypi.python.org/packages/any/p/pyserial/
pyserial-2.5.win32.exe

Step 4
Select “Next” and complete the installation of PY Serial.

Step 5
Install Python 8 support, Navigate to “Python 8 “ folder and select “wxPython2.8-win32-
unicode-2.8.12.0-py27.exe“, or download here http://downloads.sourceforge.net/wxpython/
wxPython2.8-win32-unicode-2.8.12.0-py27.exe
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Step 6
Select “Next” and follow the instructions to install Python 8 support, Note, you 
will receive a message “Do you want to allow the following program from an 
unknown publisher to make changes to this computer” - Select “Yes” and 
continue. On the final dialogue (installation complete) screen un tick 
“convert .py files to.pyc” and select “Finish”

Step 7
Navigate to the “PYREADLINE” Folder and select “pyreadline-1.7.win32.exe, or download here : 
http://launchpad.net/pyreadline/1.7/1.7/+download/pyreadline-1.7.win32.exe

Step 8
Select “Next” and follow the instructions to complete the installation of pyreadline 1.7.
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Step 9
Now we need to install PYGLET, First navigate to your reprap folder and 
check that you have a folder called “pyglet-1.1.4”, Alternatively download 
here http://pyglet.googlecode.com/files/pyglet-1.1.4.zip

Step 10
Select “Start” and then select “Run” and type “cmd”.

Step 11
At the command prompt, navigate to the “pyglet-1.1.4” folder. - from your home directory, “cd 
desktop”, “cd REPRAP”, “cd PYGLET”, “cd pyglet-1.1.4”. Now you should be in the pyglet-1.1.4 
folder, now type “setup.py install” and press return.
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Step 12
You should now see some text passing the screen, which should complete 
the installation of Pyglet, once this is comeplete, type “exit” and press 
“return”.

You have now completed the Python and Dependencies installation, please proceed to 10.4 
Pronterface/Printrun Installation
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10.4	 Pronterface Installation

	 10.4.1	Pronterface/Print Run Installation - Windows XP 

Step 1
Navigate to the “PRINT_RUN” folder and then navigate to the “kilment-Printrun-65e0121” folder 
and make sure it is located where you require, i.e. inside the “Reprap” folder 

Step 2
Navigate inside the “kilment-Printrun-65e0121” folder and right click on “pronterface.py” and 
select “send to desktop (create shortcut)”

Step 3
Now you should have a shortcut on your desktop called “shortcut to pronterface.py”, double click 
on this and Pronterface/Printrun should open - You have successfully setup Pronterface/PrintRun
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10.4	 Pronterface Installation

	 10.4.1	Pronterface/Print Run Installation - Windows 7 / Vista

Step 1
Navigate to the “PRINT_RUN” folder and then navigate to the “kilment-Printrun-65e0121” folder 
and make sure it is located where you require, i.e. inside the “Reprap” folder. Navigate to 
“pronteface.py” and right click on it and select “Send to” and then “desktop (Create Shortcut)

Step 2
Now you should have a shortcut on your desktop called “shortcut to pronterface.py”, double click 
on this and Pronterface/Printrun should open - You have successfully setup Pronterface/PrintRun
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10.5	 Skeinforge Installation

	 10.5.1	Skeinforge Installation - Windows XP

Step 1
Navigate to your “Reprap folder” and locate the “.skeinforge” folder ( in order to see this folder you 
will need to be able to view hidden files - Tools ->Folder Options->View Tab-> and select “show 
hidden files, folders & drives”. Now right click on the folder and select “copy”.

Step 2
Now navigate to the root of your home folder - “Documents & Settings” -> “Your User Name” and 
then paste the “.skeinforge folder into the root of your home directory. Skeinforge is now installed 
in the correct place for Printrun/Pronterface to use, your skeinforge profiles will be stored in this 
folder”
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10.5	 Skeinforge Installation

	 10.5.2	Skeinforge Installation - Windows 7 / Vista

Step 1
Navigate to your “Reprap folder” and locate the “.skeinforge” folder ( in order to see this folder you 
will need to be able to view hidden files - Tools ->Folder Options->View Tab-> and select “show 
hidden files, folders & drives”. Now right click on the folder and select “copy”.

Step 2
Now navigate to the root of your home folder - “C Drive/Main Drive” -> “Users” ->”Your User 
Name” and then paste the “.skeinforge folder into the root of your home directory. Skeinforge is 
now installed in the correct place for Printrun/Pronterface to use, your skeinforge profiles will be 
stored in this folder”
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10.6	 Testing Software & Communicating with the Printer

	 10.6.1	Connecting Hardware & Testing - Windows XP

Now you should have the Ardunio Driver and Development environment installed, the Python environment 
and it’s dependencies installed, pronterface/printrun and skeinforge installed. You should have a shortcut to 
the  Arduino development Environment and a shortcut to pronterface.py on your desktop. You should have 
also made a note of your “COM” Port Number (during the Arduino Driver Installation 10.1.1) and have set the 
Port Speed to “115200” within the windows control panel (10.1.2). Your Ramps Board should be powered on 
and connected to the computer by USB ( 10.1.1)
Step 1
Select the “Pronterface.py” shortcut on your desktop and pronterface should load.

Step 2
Now Select the correct Com Port from the drop down ( as noted when you installed the Arduino 
Driver 10.1.1)
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Step 3
Now Select the correct Port Speed from the Speed Dropdown and select “115200” to 
match the port speed you set earlier when you configured the port setting speed (10.1.2)

Step 4
Now Select “settings” from the top menu and select “Options” then set the e_federate value to 
“115” ( this is the speed at which the extruder will operate when pressing the manual “extrude” and 
“reverse” buttons

Step 5
Now Select “connect” from the top menu and after a short pause “connecting..... Printer is now 
Online” should appear in the dialogue menu. You have now successfully connected to the printer, 
so now we need to check the communication between the software & the printer.
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Step 6
Your RAMPS board has already been flashed with the correct firmware & settings so now 
we need to check the axis’s move as expected, first of all click on the the circle one row 
out from the outside within the X region of the circle and the X axis (extruder axis) should 
move by approximately 10mm away from the from the home end

Step 7
Now click on the “Home X” Button in the top left and now the axis should move in the opposite 
direction towards home (the endstop end of the X Axis) until it reaches the endstop and the 
endstop should click and X Axis will stop moving - NOTE if the endstop fails and x axis tries to 
keep moving select the “reset” button along the top menu bar and the printer should stop trying to 
move ( n.b. you’ll need to click on connect again after you have selected “reset”

Step 8
Now repeat the process for the Y Axis (build bed axis) and check it home’s in the correct direction, 
i.e it moves towards the end with the endstop, hits the endstop and stops.

 10.0 Computer Setup - Reprap Prusa Mendel Build Manual

©2012 NextDayReprap                                                                                        Prusa Mendel Kit Build Manual  V1.01 - 07/2012



Step 9
Now repeat the process for the Z Axis ( Vertical Movement Axis), except when you select Z 
Minus make sure the endstop is in place to stop the hot end crashing into the build bed. It’s 
best to move it a little at a time towards the home/endstop, ie select the mirror of “1” and the 
Z axis should move down by approx. 10mm and keep doing until you hit the endstop and it 
stops. If necessary adjust the endstop height/position on the vertical smooth rod of the Z axis 
to ensure the endstop is hit before the hot end hits the bed.

Step 10
Now select the “Heater Temperature” and select “230 Abs” from the drop down, ( this is the 
temperature to which the hot end will be heated and maintained) and then select the “Set” button, 
a red light will appear on the RAMPS Board.
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Step 11
Now select the “Bed Temperature” and select “110 Abs” from the drop down, ( this is the 
temperature to which the heat bed will be heated and maintained) and then select the “Set” 
button, a red light will appear on the RAMPS Board.

Step 12
Now select the tick box at the top “monitor printer” and you should now see the hot end and the 
bed temperature respectively, these will be updated every few seconds and you should see them 
going up until they reach their respective set level and then the software will maintain them near to 
their set temperatures.

Step 13
Now select “settings” from the top menu and select “Slicing Settings” and Select the “Profile Type” 
and select “Extrusion”
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Step 14
Now select “Profile Selection” and from the drop down select “Starting Point Profile” 
and select “save all” at the bottom of the window.

Step 15
Now we have set the software up and it’s connected to the printer and communicating, we need to 
move onto section 11.00 Commissioning.
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10.6	 Testing Software & Communicating with the Printer

	 10.6.2	Connecting Hardware & Testing - Windows 7/Vista

Now you should have the Ardunio Driver and Development environment installed, the Python 
environment and it’s dependencies installed, pronterface/printrun and skienforge installed. You should 
have a shortcut to the  Arduino development Environment and a shortcut to pronterface.py on your 
desktop. You should have also made a note of your “COM” Port Number (during the Arduino Driver 
Installation 10.2.1) and have set the Port Speed to “115200” within the windows control panel (10.2.2). 
Your Ramps Board should be powered on and connected to the computer by USB ( 10.2.1)

Step 1
Select the “Pronterface.py” shortcut on your desktop and pronterface should load.

Step 2
Now Select the correct Com Port from the drop down ( as noted when you installed the Arduino 
Driver 10.2.1)
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Step 3
Now Select the correct Port Speed from the Speed Dropdown and select 
“115200” to match the port speed you set earlier when you configured the port 
setting speed (10.2.2)

Step 5
Now Select “connect” from the top menu and after a short pause “connecting..... Printer is now 
Online” should appear in the dialogue menu. You have now successfully connected to the printer, 
so now we need to check the communication between the software & the printer.

Step 4
Now Select “settings” from the top menu and select “Options” then set the e_federate value to 
“115” ( this is the speed at which the extruder will operate when pressing the manual “extrude” and 
“reverse” buttons.
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Step 6
Your RAMPS board has already been flashed with the correct firmware & 
settings so now we need to check the axis’s move as expected, first of all click 
on the the circle one row out from the outside within the X region of the circle 
and the X axis (extruder axis) on the printer should move by approximately 
10mm away from the from the home end.

Step 7
Now click on the “Home X” Button in the top left and now the axis should move in the opposite 
direction towards home (the endstop end of the X Axis) until it reaches the endstop and the 
endstop should click and X Axis will stop moving - NOTE if the endstop fails and x axis tries to 
keep moving select the “reset” button along the top menu bar and the printer should stop trying to 
move ( n.b. you’ll need to click on connect again after you have selected “reset”

Step 8
Now repeat the process for the Y Axis (build bed axis) and check it home’s in the correct direction, 
i.e it moves towards the end with the endstop, hits the endstop and stops.
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Step 9
Now repeat the process for the Z Axis ( Vertical Movement Axis), except when 
you select Z Minus make sure the endstop is in place to stop the hot end 
crashing into the build bed. It’s best to move it a little at a time towards the 
home/endstop, ie select the mirror of “1” and the Z axis should move down by 
approx. 10mm and keep doing until you hit the endstop and it stops. If 
necessary adjust the endstop height/position on the vertical smooth rod of the 
Z axis to ensure the endstop is hit before the hot end hits the bed.

Step 10
Now select the “Heater Temperature” and select “230 Abs” from the drop down, ( this is the 
temperature to which the hot end will be heated and maintained) and then select the “Set” button, 
a red light will appear on the RAMPS Board.
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Step 11
Now select the “Bed Temperature” and select “110 Abs” from the drop down, 
( this is the temperature to which the heat bed will be heated and maintained) 
and then select the “Set” button, a red light will appear on the RAMPS Board.

Step 13
Now select “settings” from the top menu and select “Slicing Settings” and Select the “Profile Type” 
and select “Extrusion”

Step 12
Now select the tick box at the top “monitor printer” and you should now see the hot end and the 
bed temperature respectively, these will be updated every few seconds and you should see them 
going up until they reach their respective set level and then the software will maintain them near to 
their set temperatures.
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Step 14
Now select “Profile Selection” and from the drop down select “Starting Point 
Profile” and select “save all” at the bottom of the window

Step 15
Now we have set the software up and it’s connected to the printer and communicating, we need to 
move onto section 11.00 Commissioning.
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10.7	 Firmware

	 10.7.1	Flashing, Test & Comms - Windows XP 
Your RAMPS board has already been flashed with our build of the Sprinter Firmware, this is 
configured to work correctly with your kit. However you may wish to modify your firmware once 
your up an running to add functionality, improve performance, experiment with different settings 
and variables and make changes if you change any hardware components on the printer. 

To update/flash your firmware, we need to use the Arduino Development environment that we 
installed in section 10.2.1. and our build of the Sprinter firmware.

Our build of the Sprinter firmware is located in the folder caller “SPRINTER” on the disk supplied 
with your kit, if you look inside the folder you should find a subfolder called “sprinter” and inside 
that you should see some .h files and a file called “sprinter.pde” - this is your firmware file that 
needs to be opened within the Arduino development. This will then allow you to modify the settings 
within the firmware and upload it to the chip on the RAMPS board. Note you can’t actually view the 
firmware that is on the chip or “rip” the firmware from the chip, so it is probably prudent to make a 
backup copy of our sprinter folder, before you start adjusting any settings.

Make sure your hardware is connected and turned on as per 10.1.1

Step 1
Open the Arduino Environment by selecting the shortcut(10.2.1) we created earlier on your 
desktop, you should then be presented by the following screen - Note, DO NOT update to the 
latest version when the Arduino software prompts you too. Then select “Tools” from the top menu 
and select “Serial Port” and set this to the com port we noted earlier (Step 3 10.1.2.1).
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Step 2
 Now select “Tools” from the top menu and select “Board” and set this to “Arduino Mega 
2560”.

Step 3
 Select “File” -> “Open” and navigate to your “SPRINTER” folder and select the file 
“Sprinter.pde” and select “Open”
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Step 4
 A new window should now open with various tabs across the top below the main menu. 
The 1st tab should read “Sprinter” and the second tab should read “configuration.h”, this is  
the tab we need to select and then we can adjust the variables within this tab to modify the 
firmware.

Step 5
 Now we can select the “configuration.h” file and here we can make modifications to the 
firmware variables, such as setting the main board type, thermistor types, steps per mm etc. 
Please refer to section 11.7.4 Firmware variables for guidance on what the values within this 
file mean and calculating them.
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Step 6
Once modifications have been made to the “configuration.h” file, then it can be uploaded 
to the RAMPS Board, to do this select the right arrow icon button from the icon buttons 
across the top, and then you should see a message at the bottom of the screen saying 
“Uploading to I/O Board”

Step 7
The status box at the bottom of the window should then display “Binary sketch size: ????? 
bytes (of a ????? bytes maximum”.
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Step 8
After a just under a minute the status box should display “Done Uploading..”. You have 
now successfully flashed/uploaded your modified firmware to the RAMPS Board. You 
should now save your modifications by selecting the button icon on the far right or 
selecting “File” -> “Save”. For help on the actual firmware variables, there meaning and 
calculating their values please read section 10.7.4 - Firmware Variables
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10.7	 Firmware

	 10.7.2 Flashing, Test & Comms - Windows 7 / Vista 

Your RAMPS board has already been flashed with our build of the Sprinter Firmware, this is 
configured to work correctly with your kit. However you may wish to modify your firmware once 
your up an running to add functionality, improve performance, experiment with different settings 
and variables and make changes if you change any hardware components on the printer. 

To update/flash your firmware, we need to use the Arduino Development environment that we 
installed in section 10.2.2. and our build of the Sprinter firmware.

Our build of the Sprinter firmware is located in the folder caller “SPRINTER” on the disk supplied 
with your kit, if you look inside the folder you should find a subfolder called “sprinter” and inside 
that you should see some .h files and a file called “sprinter.pde” - this is your firmware file that 
needs to be opened within the Arduino development. This will then allow you to modify the settings 
within the firmware and upload it to the chip on the RAMPS board. Note you can’t actually view the 
firmware that is on the chip or “rip” the firmware from the chip, so it is probably prudent to make a 
backup copy of our sprinter folder, before you start adjusting any settings.

Make sure your hardware is connected and turned on as per 10.1.1

Step 1
Open the Arduino Environment by selecting the shortcut(10.2.2) we created earlier on your 
desktop, you should then be presented by the following screen - Note, DO NOT update to the 
latest version when the Arduino software prompts you too. Then select “Tools” from the top menu 
and select “Serial Port” and set this to the com port we noted earlier (Step 3 10.2.2.1).
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Step 2
 Now select “Tools” from the top menu and select “Board” and set this to 
“Arduino Mega 2560”.

Step 3
 Select “File” -> “Open” and navigate to your “SPRINTER” folder and select the file 
“Sprinter.pde” and select “Open”

Step 4
 A new window should now open with various tabs across the top below the main menu. 
The 1st tab should read “Sprinter” and the second tab should read “configuration.h”, this is  
the tab we need to select and then we can adjust the variables within this tab to modify the 
firmware.
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Step 5
 Now we can select the “configuration.h” file and here we can make 
modifications to the firmware variables, such as setting the main board type, 
thermistor types, steps per mm etc. Please refer to section 11.7.4 “Firmware 
variables” for guidance on what the values within this file mean and 
calculating them.

Step 6
Once modifications have been made to the “configuration.h” file, then it can be uploaded 
to the RAMPS Board, to do this select the right arrow icon button from the icon buttons 
across the top, and then you should see a message at the bottom of the screen saying 
“Uploading to I/O Board”

Step 7
The status box at the bottom of the window should then display “Binary sketch size: ????? 
bytes (of a ????? bytes maximum”.
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Step 8
After a just under a minute the status box should display “Done 
Uploading..”. You have now successfully flashed/uploaded your modified 
firmware to the RAMPS Board. You should now save your modifications by 
selecting the button icon on the far right or selecting “File” -> “Save”. For 
help on the actual firmware variables, there meaning and calculating their 
values please read section 10.7.4 - “Firmware Variables”
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10.8	 Firmware Variables

	 10.8	 Firmware Variables

All main variables that you are likely to want to modify are located in the “configuration.h” file. Here 
we will list the main variables, their functions and how to calculate their values. The file is quite well 
documented itself, you can add your own comments or remove lines by placing “//” at the 
beginning of the line.

#define MOTHERBOARD
This value tells the chip which kind of board it is connected to.
Possible Values :
3 - MEGA/RAMPS up to Version 1.2
33 - RAMPS 1.3 and above
5 - Generation 6
6 - Sanguinololu up to 1.1
62 - Sanguinololu 1.2 and above
21 - Generation 3 Plus
22 - Generation 3 Monolithic Electronics 

Our Kit Value :
We use RAMPS 1.4 so our value is :
#define MOTHERBOARD = 33

We use the Arduino Development environment to view and edit the the firmware, please refer to 
section 10.7.1 (XP) or 10.7.2(Vista/Win7) for instructions for using the development environment.

#define THERMISTORHEATER 
#define THERMISTORBED
These values tell the chip which kind of thermistors are being used for the Hot End and the Heat 
Bed respectively.
Possible Values :
1 - 100K Thermistor
2 - 200K Thermistor
3 - Mendel-Parts Thermistor
4 - 10K Thermistor
5 - Parcan supplied 104GT-2 100K
6 - EPOCS 100k

Our Kit Value :
We use 100k Thermistors for both the Hot End and the Head Bed so our values are :
#define THERMISTORHEATER = 1
#define THERMISTORBED = 1
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float axis_steps_per_unit[X,Y,Z,E]
These values tell the chip the number of steps the stepper motor needs to make 
to move the respective axis or extruder by 1mm. There are four values and they 
which correlate to to “the x axis”, “the Y axis”, “the Z Axis” and the “Extruder” 
you will notice that there are preset values here for different types of printer.

To calculate these values we need to take a few hardware variables into account.

Calculate X & Y values
1. Motor Step Angle/Size
2. Motor Driver Microstepping
3. Belt Pitch
4. Tooth Count

We can then apply the above values into the following equation to give us the steps per mm value 
for the X and Y Axis
Steps per mm = ((360°/Motor step size°) * (1/Driver microstepping))/(Belt pitch * Tooth count)

We use Stepper Motors with a 1.8° Step Angle and 1/16 Microstepping on the A4988 Polulo 
Stepper Drivers, our belts are T5 Pitched and we use 12 tooth Pulleys so our value calculates as 
follows :
Steps per mm = ((360°/1.8°) * (1(1/16)))/(5 * 12)
= 53.333333 Steps per MM 
As this results in a recurring number we round it to the nearest non recurring number hence our 
value of 53.2mm

This is the value we use for X and Y axis

Calculate Z Axis value

To Calculate the the Z axis value we use a fraction (steps for a 360° rotation of stepper/Threaded 
Rod Pitch), as our our Motors have a 1.8° step angle and the Pololu A4988 Stepper Drivers use 
1/16 stepping this results in 3200 (360/1.8)= 200 then multiply by 16 results in 3200. The pitch of 
our Z Axis Rod is 1.25, so the value for our Z axis is “3200/1.25”

Calculate the E Axis value

This is the value for the Extruder and this is the one variable you might like to play around with as it 
is affected by the type of filament used. The default value used is “1487” in order to test weather 
this is accurate for your printer we need to perform a test. We need to extrude a set distance of 
filament and then measure how much has actually extruded and any variance between the 
requested distance and the actual distance then needs to be factored into the default value. 

The default extrude distance set to 5mm for the manual extrude button within pronterface, so we 
then need to mark the filament and measure how much the filament actually moves. The bigger 
distance you measure the more accurate your results will be so we’ll start with 50mm.
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Calculate the E Axis value Cont....

Now we have changed the manual extrude value to 50mm, we need to mark
the filament with a marker pen, mark it say 100mm along from where the 
filament enters the extruder, i.e. measure 100mm from the where the filament
enters the extruder. Now with the printer connected and up to temperature,
press the extrude button and let it complete the extrusion. Now measure the distance between the 
where the filament enters the extruder and the mark you made and this distance should equal 
50mm. If there is any variance from 50mm we need to do a calculation to ascertain the correct 
value for “E”.

Take the Extruded amount requested (50mm) and multiply by the current “E” value (1487) then 
divide this by the amount of filament actually fed though (i.e. the difference between your mark and 
a movement of 50mm)

So for example “E” is set to “1487” the requested extrude was 50mm and the actual extrude was 
48mm so we would calculate the following (50x1487)/48= our new “E” Value (1548.95)

The longer the amount you extrude and measure the more accurate you will be able to get this 
value.

const bool ENDSTOPS_INVERTING=true;
This value defines the behavior of the endstops setting the value to “true” inverts the the logic of 
the endstops 

#define BAUDRATE 115200
This value determines the the baud rate (speed) of the serial port that printer is connected to. This 
should be the same value as set in “port settings” in 10.1.2 & 10.1.3 and should be reflected in 
within Pronterface (10.6.1 Step 3)

#define SDSupport
This value determines weather SD support is required comment it out by preceding it with a ”//”.

#define X_ENABLE_ON 0
#define Y_ENABLE_ON 0
#define Z_ENABLE_ON 0
#define E_ENABLE_ON 0
These values enable you to invert the stepper motor enable pins (shouldn’t need to touch these)

const bool Disable_X = false;
const bool Disable_Y = false;
const bool Disable_Z = true;
const bool Disable_E = false;
These values disable the respective axis when they are not being used, so the motor’s don’t “hold” 
them whilst there idle, during printing.

const bool INVERT_X_DIR = true;
const bool INVERT_Y_DIR = true;
const bool INVERT_Z_DIR = true;
const bool INVERT_E_DIR = true;
These values will invert the direction of the respective axis if set to “true”
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#define X_HOME_DIR -1 
#define Y_HOME_DIR -1 
#define Z_HOME_DIR -1 
These values set the direction of the endstops when homing, “-1”=MIN  & “1”=MAX

const bool min_software_endstops = false;
If this value is set to true the axes won’t move  to coordinates less than zero.

const bool max_software_endstops = true;
If this value is set to true the axes won’t move to coordinates greater than the defined lengths 
(below)

const int X_MAX_LENGTH = 200;
const int Y_MAX_LENGTH = 200;
const int Z_MAX_LENGTH = 135;
These values determine the maximum build area, i.e. the maximum length away from home that 
can be travelled on the respective axis.
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A step by step guide for building your Prusa Mendel 3D Printer Kit.

This section will take you through the final steps in setting up your printer and printing your first prints. Some 
areas of the commissioning will be related to your computer set up We recommend you read through both the 
computer set up sections and commissioning sections before starting either. These sections include instructions  
for setting up important parts of your printer and both should be carried out at the same time.

Step 1
Check that the surface your printer will be used on is level. Position your printer where is will be 
used. Remember to allow enough room for the bed to move fully. Leave space for your 
electronics and the Power supply. Now check that all nuts on your printer frame are tight. The 
printer should sit squarely and not twist.

11.1 	Frame Leveling
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Step 2
Take a small spirit level (A weighted piece of string will also work if you do not have a small 
spirit level) and hold it against one the smooth rods on the outside on the Z Axis. Loosen the 
M8 nuts next to the lower Z axis and move the axis until your Z Axis is level then tighten. 
Repeat this for both of the Z Axis.

Step 3
Now measure then gap between your work surface and the base of the X End Motor Mount. 
Make a note of this and then hold the coupling tight on that Z Axis. Twist the opposing Z Axis 
coupling to raise or lower your X Idler Mount until it is the same height as the other X end.

If you have a spirit level you can use it to ensure your X Axis is perfectly level by place across 
the ZX Axis smooth rods. Turn the Couplings until level.
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Step 1
Check that all four corners of your bed have the springs securely in place. Measure the height 
from your work surface to the wooden bed in one corner. Adjust the corner screws until all four 
corners are the same height.

11.2 	Bed Leveling

Step 2
If you have a spirit level you can use it to ensure your bed is perfectly level. Place it on each 
edge of the bed and adjust the bed screws to level.
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Step 3
If you are using a Heated bed plate We recommend you level your bed at each stage. You 
should level the wooden bed, then add your heated bed and use your bulldog clips to hold in 
place then check the level of your bed again and adjust it if needed. Additionally if you use one 
of our mirror beds or another glass layer we recommend you use bulldog clips to clamp the 
mirror and heated bed down and then check the level of the bed.

Step 4
Now bring your Z axis down until the tip of the Hotend is approximately 10mm from the bed. If 
you have set up your computer you can use the software to lower the Axis. Be careful not to go 
too far as you risk damaging the Hotend nib against your bed. If you have not set the computer 
you can twist the couplings at the same time to bring both sides of the X Axis down. Once you 
have lowered the Axis Check it is still level and adjust it if needed.
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Step 5
If your computer is set up, turn off the motors. If you are not connected make sure your X 
Carriage and Bed are both free to move. Now while watching your Hotend nib move the bed 
back and forward. Watch to see if the gaps between your bed and the Hotend stays consitent. 
If you see that the gap changes, adjust the bed corners to bring it level. Do the same with the X 
Axis. Move the X Carriage side to side  and watch the Hotend tip. Adjust the X Axis by truning 
the Z Axis couplings while holding the other still. This will raise or lower the end.

Step 6
Repeat these steps while gradually lowering the X Axis down the Z Axis. Ensure the Hotend 
stays level above the bed until it 1-2mm from the bed. Now slide a peice of paper between the 
nib and your bed.
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The Endstops are used by your printer to know where so start and stopped. they are triggered 
when the metal pin on the microswitch is pressed, the motor on the coresponding axis will 
stop (reached home).

11.3 End Stops

Step 1
The Z Axis end stop Can be pushed up against the base of the X end so that the pin is 
depressed. Your Hotend should be close to the right height following the previous steps. Now 
using the software raise your Z axis up by 10-20 mm. Then lower your Z Axis by the smallest 
increments, position the end stop so the switch is pressed before the Hotend nib touches the 
bed surface. The correct gap between bed and nib is 0.5mm. Using the peice of paper you left 
between the nib and bed, lower the Z Axis until the nib is a close as possible but you can still 
move the paper.
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Step 2
To get the X axis Endstop in the correct position, check that when the X Carriage moves along 
the rods, part of the extruder body should make contact with the switch. when the X Carriage 
is all the way across and the switch is depressed check that the Hotend nib is above the bed 
still and if it has gane past or will catch on your bulldog clips then bring the Endstop in along 
the rod to adjust.

Step 3
Ensure the Y Endstop is in position to be activeated by the Aluminum bed when it returns 
alongs its axis. Check that your bulldog clips and cables do not catch on it.

Step 4
With your Endstops in place and your frame and bed level ensure your computer software is 
set up and test the movement of your printer. Make sure that your Axis move in the correct 
direction and check there is no excess statin on belts or pulleys. Check for any loose nuts and 
bolts.
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The Pololu A4988 Stepper Drivers have already been assembled, calibrated and mounted to 
your RAMPS Board. But it may be necessary to adjust them slightly if you are experiencing 
certain issues, such as missing steps ( when the print staggers in an Axial direction) or if you 
are experiencing extrusion consistency issues). Either way the following is for your reference to 
help you understand how the stepper drivers affect the printer.

We use low voltage Nema 17 Stepper Motors which can take a maximum current of 1.68A at a 
2.8V the  Polulo A4988 Stepper Driver can drive up to 2A, this is far higher than the level 
required, resulting in the stepper motors running a lot cooler.

There is a very fine line between too much current and too little current in relation to the 
accurate operation of the stepper motor itself.

The best starting point is about 0.7x the rated current, this is the maximum current the stepper 
driver can output before requiring a heat sink ( n.b Heatsinks are already fitted).

You can calculate the approximate required Vref Voltage value by applying the following 
calculations :

Vref = Stepper Motor Max Current x Factor Current x 0.4 

Vref = 1.85A X 0.7A x 0.4 = 0.47V

So now select DC Current on your Multimeter to two decimal places

11.4 Adjusting Stepper Motor Drivers



Step 2
With power connected and on and the stepper motors connected, locate the Vref Adjustment 
Pot and looking at the stepper driver in the following orientation  the 2nd pin in from the left 
along the top row and measure the current by putting the ground probe on the 2nd pin from 
the left on the top row and the positive probe on the adjustment pot, poke the probe into the 
pot until you get a reading on your multimeter. Make sure you don’t slip and touch any of the 
other pins as this could damage the stepper driver
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Step 4
Now you have adjusted the pot slightly re-read the Vref voltage as in step 2 and you should see 
the change in the Vref from the adjustment you made, now you should have a feel for the amount 
of change in Vref in relation to the degree change of the pot. A value of between 0.4v and 0.5v is 
appropriate for the Stepper Motors in you kit. 

You should notice a physical change in the behaviour of the stepper motor as the Vref is 
manipulated, when it is too low the stepper motor will make a noise and vibrate as if it were 
moving but it will fail to move or move accuratley, if the Vref and hence current is too high the 
stepper motor will move in jerky overly highly torquey manner ( it will seem unnecessarily 
powerful for the printer) and after a certain point the motor won’t move again and will vibrate 
and get very hot. 

Depending upon which motors are being used more heavily when printing will depict how 
warm/hot they get along with their respective heat sinks on the stepper drivers, so for example 
the Extruder stepper may well be considerably hotter than the z axis stepper motor as it is 

Step 3
Now we have a reading of the Vref voltage, it should be between 0.40 and 0.50v, if we wish to 
adjust it we need to turn the pot slightly, if we turn it clockwise we’ll increase the current drawn 
and anti clockwise we’ll reduce it. Use an insulated small slotted screwdriver to turn the pot 
slightly. There is a flat side to the pot, usually this should sit at around the 10/11 O’Clock 
position.
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In the Pronterface software check the figure in the Heater dialog box. Make this 230 if not 
already. Click “Set” in the next box. You can now click “Check temp”. Pronterface will show 
you a reading. You Hotend should get to 230 in a couple of minutes. The check box at the top 
in Pronterface labelled “Monitor Printer” will start Pronterface regular temperature checks and 
the latest temperature for Hotend and Bed will be displayed.

11.5 Hotend

You can now turn on the heated bed. In the Pronterface software check your bed temp is 110 
in the dialog box and click “Set”. The Bed is much slower to heat than the Hotend. Also any 
further layers on your heated bed will take longer to heat. If you are using a mirror or glass bed 
leave your bed heating for a further 10 minutes after Pronterface shows the temp has reached 
110.

11.6 Heated Bed
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Step 1
To load filament for the first time, start by ensuring your Hotend is at the correct temperature 
(230 for ABS). Ensure your motors are set to off in the Pronterface software. Remove the two 
sprung bolts from the Extruder Idler and pull the Idler down.

11.7 Loading Filament

Step 2
Take the end of your filament and ensure is has no kinks or twists in it. Take the end of your 
filament and using wire cutters or a stanley knife cut diagonally across the filament. This 
creates a pointed end to ease feed to filament on to your Hotend.
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Step 3
Feed the filament between the top threaded rods of the printer. Feed it down through the hole 
in the top of the extruder. When is gets to the hobbed bolt the filament will be pushed away 
from the lower hole. Use small pliers to push the filament down throught the lower hole. Once 
in turn the large gear on the extruder to feed the filament through.

Step 4
Keep feeding the filament until it reaches the bottom of the Hotend, you should see the 
filament start to ooze from the Hotend. Keep your fingers loosely gripped on the filament as it's  
being sucked into the extruder to ensure it doesn't foul and stop being pulled through.
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Step 5
Now pull the Idler back up and Put the two sprung bolts back in. Tighen the bolts so the 
bearing in the idler pushes the filament against the Hobbed bolt.

Step 6
Now you can test extruding filament from the Pronterface software. Use Pronterface to move 
your axis so that the Hotend tip is approximately 50mm from the bed. In Pronterface check 
that the Extrude length is 5mm and click “Extrude”. You should see filament come out of your 
Hotend. Now increase the extrude length in pronterface to 50mm and click “extrude”. Watch 
the filament as is releases. You should see a consistent line extruded at a consistent speed. If 
your filament is extruding fast then slow or it is coming out at different thicknesses, adjust the 
tension on the two sprung extruder bolts. Tightening them will push the filament against the 
hobbed bolt increasing grip. If these are too tight the filament will grind against the hobbed bolt 
and not extrude.
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Step 1
Always ensure you Hotend is up to temperature before removing filament (230 for ABS). Turn 
off the motors in the Pronterface software (Button Located on the top left hand side). Then 
remove the two Sprung bolts in the extruder idler. 

11.8 Removing Filament

Step 2
Grip the filament above the extruder and pull up in one swift movement. This ensures the 
filament comes out cleanly and no blobs of plastic are left behind. You may find it helpful to 
turn the large gear on the extruder in reverse as you pull the filament up.
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Step 3
Whenever removing filament, always check your Hotend is fully located in the extruder recess 
before reloading. If necessary you can loosen the Hotend clamp an holding the Hotend with 
pliers or grips push up into position and retighten the Hotend Clamp.



When changing a hot end always remove the filament before starting and always remove when 
the hot end is at full temperature (230°C. (Refer to 11.7)

We recommend allowing your hotend to cool before changing.

Loosen the hotend clamp and grip the hotend with large pliers around the aluminium heater 
block.

Take care not to crush the thermistor and resistor cables. Slide the hotend down and out of the 
extruder and through the hotend clamp. Then disconnect the cables. 

When changing a hot end always check that the PTFE disc stays in place in the extruder recess. 

Always check for debris in the extruder and hotend. If your hotend will remain out of your printer 
for some time place a strip of kapton tape over the hole and ensure the brass nib does not get 
damaged. 

Refit or install your replacement by sliding through the hotend clamp and in to the extruder 
recess. Ensure it is all the way in and tighten the hot end clamp. Always check the Z endstop 
home position after changing hotends.
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11.9 Changing Hotends



Assuming you have worked though section 10.0 Computer setup and installed all the required 
software & drivers, you are now ready to complete your 1st test print.

The printer should be powered up and connected to the computer (as in section 10.0) and 
Filament loaded into the extruder and hot end (Section 11.6)

Now open Pronterface ( by clicking on the pronterface.py shortcut that we created in section 
10.0). Now connect to the printer and set the temperature of hot end (heater) and the heat bed 
and wait a few minutes whilst the printer gets up to temperature. 

Now we need to generate some Gcode from an STL 3D Design file. The Gcode is the list of 
commands that is directly transmitted to the printer. In order to generate the G Code we need 
to use the “compose” function of Pronterface, this creates a graphical representation of your 
print bed, allows you to position the object on the heat bed and then pronterface generates the 
Gcode by using Skeinforge (Pronterface acts as a front end for Skeinforge).

Click compose and the following window will appear, then select load and navigate to your 
Reprap folder and the “STLs” folder inside the folder you should find a file called 20mm-
box.stl, select this file and open.
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11.10 Printing A Test Part



Now you should a green graphical representation of the object to be printed in the bottom left 
of the window. Click and hold on the object and drag it into the centre of the build area, note 
you can also rotate the object by holding down “alt” and scrolling.

Now select done and the compose window will close and the pronterface dialogue will start 
showing a log of the G Code as it is being generated, depending upon how fast your computer 
is and the size and complexity of the object will affect the time taken to generate the G Code. 
On a relatively modern dual core machine it should take less than a minute or so to generate 
the code for the test cube, the log will indicate once it’s complete and an image should appear 
in the central window.

The Gcode that is generated is stored in a folder called “Temp STL” inside the Printrun/
Pronterface application folder. If you want to keep the gcode you generated to save generating 
it again in the future, copy the generated g code file and store it somewhere else, then you can 
just select file open and open the Gcode file directly within pronterface.
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Now ensure the printer is up to temperature by selecting check temp and or ticking the monitor 
printer box, once the hot end is up to 230°C and the heat bed is over 100°C you are ready to 
print. Assuming you have completed the bed leveling section earlier in this chapter, click the 
home all axis button the white button with a home symbol in the bottom left of the axis control 
button area.

The printer should now move all of the axis to their respective home positions, now you can 
press the print button.
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Once you have pressed print watch your printer lay down the first lines of plastic. Your plastic extrusion 
should come out smoothly and adhere to your print surface. Watch as the printer turns corners. Make 
sure the plastic sticks to the bed and doesn't pull off. common causes are that the bed is not hot 
enough or the z axis endstop is to high. If your plastic is being squashed down against your bed by the 
hotend nib your Z axis endstop may be too low and you risk damaging the bed. This is when having 
your power supply main switch close can help avoid accidentally scraping the hotend nib on the bed. If 
your hotend does scrape your bed or hit a bulldog clip you should always check and reseat the hotend. 

Watch as your printer builds the first layer. If the lines judder, check your bed and X axis movement. 
Check they both move smoothly. Add some bearing grease or a small dab of oil to the smooth rods to 
help the bearings. You should regularly twist the rods to avoid constant bearing wear. Then check the 
tension of the X and Y belts. They should have some flex but you should not be able to slip the teeth 
around the motor gear. 

Your plastic should come out in smooth lines and consistent speeds. If it is not lift the Z axis and 
extrude 50mm through the hotend. Check whether it is consistent. Adjust the sprung bolts on the 
extruder and check by extruding again. If it remains inconsistent check your stepper motor drivers and 
check the teeth on your cogs. If your prints remain inconsistent but when tested straight through he 
extruder it is fine, you should check your skienforge settings.



If the printer is not adhering or the layers are not in line you can pause your printer from 
pronterface. Raise the Z axis to move the hotend away and remove the misprint. Once you've 
resolved the cause you can reprint from pronterface. Always move your hotend to the home 
position before restarting your print.

When the cube is complete the hotend will move away. The bed and hotend will turn off and 
begin to cool. You should allow the print to cool before removing from the bed. Be careful not 
to damage the heated bed when removing prints.

Move your hotend to its home position and set the heated bed and hotend temperature and 
you are ready to print again.
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Health & Safety

This is a kit of components for assembly into a 3D Printer by the end user. Building and using the printer is 
potentially very dangerous as it involves electricity and high temperatures. 

Building the printer will  require a certain amount of physical dexterity, common sense and a thorough 
understanding of what you are doing. We have provided fully comprehensive build documentation to enable 
you to build your Prusa Mendel 3D Printer Kit in a safe manner, we have pre assembled many of the more 
complicated components, such as the electronics to make it easier for you.

However ultimately we cannot be responsible for your health and safety whilst building or operating the 
printer, with that in mind be sure you are confident with what you are doing prior to commencing with building 
or buying. Read all of the manual to enable you to make an informed decision.

Building and operating involves electricity, so all necessary precautions should be taken and adhered to, the 
printer runs on 12V supplied by a certified power supply, so you shouldn’t ever have to get involved with 
anything over 12V but bear in mind there can still be high currents involved and even at 12V they shouldn’t be 
taken lightly. 

High temperatures are involved with 3D Printing, the Extrusion nozzle of the hot end runs at 230°C, the 
heated bed runs a 110°C and the molten plastic extruded will initially be at around 200°C, so special care and 
attention should be made when handling these parts of the printer during operation.

We wouldn’t recommend leaving your printer running un attended, or at least until you are confident to do so. 
We cannot be held responsible for any loss, damage, threat, hurt or other negligent result from either building 
or using the printer.
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Regular lubrication of the X and Y Axis is important for the longevity and smooth running of 
your printer. These axis should always move without much resistance, if you were to lift one 
end of the printer the y carriage should move under it’s own weight by gravity. The rods can be 
lubricated with oil or grease. Ideally bearing grease should be used (from a local auto supplier) 
and apply generously to both the X Axis and Y Axis.  

In terms of frequency, this will depend on how heavily you are using the printer, but as a 
general rule, the axis’s should never be “dry” to touch, they should be lightly lubricated.

When lubricating the axis it is also recommended to rotate the axis slightly to prevent bearing 
wear on the rod itself. Do this by loosening the bar clamps and rotating the rod slightly.

A step by step guide for building your Prusa Mendel 3D Printer Kit.

Some guidance and tips for looking after your 3d printer and keeping it working effectively and efficiently. 
The extent to which this guidance needs to be implemented will depend on how heavily you are using your 
3D Printer. This guidance should be read in conjunction with the rest of this manual.

12.1 	Axis Lubrication

General
Visually check the printer before commencing a print to check everything is where it is supposed to 
be to prevent any unexpected problems, because the printer has many moving parts it is important 
to make sure nothing becomes disconnected or dislodged that goes un-noticed prior to 
commencing a print. 

Endstops -  Make sure they haven’t moved on their respective axis and that they are 
  connected electrically 

Axis -   Make sure they are tightly gripped and don’t have any vertical or horizontal 
  movement.

When sending manual commands to the printer from the Pronterface software, always pay 
attention to what the printer is actually doing and make sure you don’t issue any commands by 
accident. As a rule always move the axis in smaller steps ie 10mm at a time rather than 100mm at a 
time, this is because the printer is controlled serially and the commands will queue and execute 
sequently irrespective of what happens physically. Don’t ever over/aimlessly click on buttons in the 
software, as the commands will queue and keep sequentially operating.

For example, the z endstop becomes slightly loose and moves slightly, then when you home the z 
axis (prior to printing) the endstop gets missed and the hot end crashes into your build bed, if 
you’re moving in smaller increments you are less likely to do any damage etc.

Because the printer communicates serially and commands are queued in batches, there can be a 
slight delay between pressing “pause” or “stop” and the printer actually stopping, so it’s handy to 
always have quick/easy access to the power switch on the PSU, so in the event the printer behaves  
unexpectedly or you enter an inappropriate / erroneous command you can just cut the power 
before any damage is done ( this won’t damage the electronics). 
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12.2 	Hot End & Nozzle

Keep your Hot End Nozzle clean, don’t let molten plastic build up on it as this will cause issues 
when starting prints. Brillo/ Scotch Brite Pads or a scourer are a good way of keeping it clean. 
It’s easiest to keep it clean as you go, by using tweezers to remove excess plastic in between 
printing and not letting it stick to the nozzle.

Visually ensure wiring and connections haven’t moved and are still located in their correct 
positions, pay special attention to the hot end thermistor, if this moves away from the hot end 
heater block it will result in the electronics applying more power to the hot end to maintain it at 
a higher temperature as an offset to the thermistor being further away, this could result in the 
electronics cutting the power to the hot end as too much current is drawn. This would then 
result in the hot end cooling mid print, and then the filament will grind out in the extruder and 
you will need to reload the extruder and start the print again

Check the nuts and washers across the printer to ensure they are still tight and haven’t worked 
loose, as the printer move’s and vibrates a lot, it is prudent to check these regularly. It is 
important they don’t work loose as it can affect the geometry and stability of the 3D Printer

12.3 	Nuts & Bolts

The Extruder is one of the hardest working parts of the printer. 

Every so often open the extruder Idler and clean out any loose plastic and plastic debris that 
may have built up on and around the hobbed bolt. Using a small tooth brush or hand held 
vacuum is very effective, clear out any loose debris, you should do this everytime you change 
filament anyway.

Visually check the drive and driven gears for wear and to ensure no teeth have broken or 
become damaged, this might not be obviously visible, make sure you look closely. This could 
result in uneven/inconsistent extrusion.

Check the drive and driven gears still consistently mate together tightly.

Check that the hot end is still tightly clamped into the extruder and is still located in it’s original 
position, in that it hasn’t moved or slipped at all.

12.4 	Extruder & Gears
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Always keep the electronics in an open, ventilated area, located in such away that you’re not 
going to drop any conductive debris on them ( such as nuts & washers etc).

Regularly check that the pc header connectors on the Ramps board haven’t worked loose or 
become disconnected, especially the Endstop and thermistor connections. 

Every so often, check all of the slotted screw terminals on the the associated power 
connections on the RAMPS board and tighten them where necessary.

Make sure both the Bed Thermistor and Hot End Thermistors haven’t moved or dislodged from 
their positions on the printer.

Make sure the connectors on the endstops are still homed tight and in position.

12.6 	Pulley Grub Screws & Belt Tensions

Make sure that the grub screws holding the X & Y Pulleys and the Extruder Drive Gear are tight 
and that the pulleys never/ can’t slip.

Over time and the more you use your 3d printer the X and Y timing belts will loosen slightly, so 
you need to check their tensions and tighten them if they have become loose or looser

12.5 	Electronics

12.7 	Build Surface

Make sure you keep your build surface, clean, dry and free of oil/grease. In order for ABS 
Plastic to adhere to the build surface and to prevent warping, you will be using kapton tape on 
your build surface. The kapton tape will need to be replaced and re applied to the build plate 
when it gets damaged, scratched and scuffed. You can use your judgment as to when you 
need to, but to ensure a smooth base on the printed object, you’ll need to ensure the kapton 
tape is in good order.

12.8 	Bed Leveling

When ever you move your printer or place it on a different surface, you should re level your bed 
as in section 11.0 Commissioning to ensure an even gap between the hot end nozzle and the 
build surface. 

It is very important that your bed is correctly leveled, for example if the bed is too high in one 
corner of the build bed, when the hot end moves over that area of the bed it will drag and 
scrape on the bed, potentially damaging the hot end and the build bed surface.
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12.9 	Plastic Parts

Certain plastic parts on the printer are prone to wear more than other parts, so once you’re up 
and printing it would be prudent to print some spare parts for yourself. 

Parts we recommend printing are the Extruder Drive Gear, The Extruder Driven Gear,  The 
Extruder, X Carriage, Hot End Clamp and Endstop Holders. The design files for these parts are 
included on the software CD that came with your Prusa Mendel 3D Printer kit or you can 
download them from our website http://www.nextdayreprap.co.uk/downloads . These parts are 
more prone to wear as they are either heavily used or regularly adjusted.

You need to ensure all the LM8UU Bearings maintain their correctly seated placement within 
the plastic parts. This is especially important on the Y carriage, as these bearings can be 
knocked out of alignment with the bearing pillows, if the y carriage has been moved in an 
erroneous fashion. For example you move the y axis 100mm away from home by pressing the 
button in the pronterface software, but there is only 60mm left of free axis, so when the 
instruction is sent the printer keeps trying to move the Y Axis for another 40mm after it has hit 
the end, this could result in the bearings nudging within their mounting pillows. This would then 
cause the bed level to be changed without you realising, so when you went to print the hot end 
nozzle would either crash into part of the bed or be too far away from it.

Visually and physically check that all four of the LM88UU Bearings are mounted level and even 
within the printed plastic bearing pillows on the underside of the Y Carriage, if necessary re 
seat and align them ( as per section 5.0 Y Carriage Assembly). 

For the X Carriage and Z Axis visually check  the bearings are level and evenly located and that 
the cable ties are tight and tighten them as necessary.

12.10  Bearings
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